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Copyright

This document is owned and copyrighted by Motion Control Engineering. All Rights Reserved.
Upon request by Motion Control Engineering, this document must be returned to Motion Control
Engineering. ©Motion Control Engineering, 2022.

Trademarks
All trademarks or registered product names appearing in this document are the exclusive property
of the respective owners.

Warning and Disclaimer

Although every effort has been made to make this document as complete and accurate as possible,
Motion Control Engineering and the document authors, publishers, distributors, and
representatives have neither liability nor responsibility for any loss or damage arising from
information contained in this document or from informational errors or omissions. Information
contained in this document shall not be deemed to constitute a commitment to provide service,
equipment, or software by Motion Control Engineering or the document authors, publishers,
distributors, or representatives.

Limited Warranty

Motion Control Engineering (manufacturer) warrants its products for a period of 15 months from
the date of shipment from its factory to be free from defects in workmanship and materials. Any
defect appearing more than 15 months from the date of shipment from the factory shall be
deemed to be due to ordinary wear and tear. Manufacturer, however, assumes no risk or liability for
results of the use of the products purchased from it, including, but without limiting the generality
of the forgoing: (1) The use in combination with any electrical or electronic components, circuits,
systems, assemblies or any other material or equipment (2) Unsuitability of this product for use in
any circuit, assembly or environment. Purchasers’ rights under this warranty shall consist solely of
requiring the manufacturer to repair, or in manufacturer's sole discretion, replace free of charge,
F.O.B. factory, any defective items received at said factory within the said 15 months and
determined by manufacturer to be defective. The giving of or failure to give any advice or
recommendation by manufacturer shall not constitute any warranty by or impose any liability upon
the manufacturer. This warranty constitutes the sole and exclusive remedy of the purchaser and
the exclusive liability of the manufacturer, AND IN LIEU OF ANY AND ALL OTHER WARRANTIES,
EXPRESSED, IMPLIED, OR STATUTORY AS TO MERCHANTABILITY, FITNESS, FOR PURPOSE SOLD,
DESCRIPTION, QUALITY PRODUCTIVENESS OR ANY OTHER MATTER. In no event will the
manufacturer be liable for special or consequential damages or for delay in performance of this
warranty.

Products that are not manufactured by MCE (such as drives, CRTs, modems, printers, etc.) are not
covered under the above warranty terms. MCE, however, extends the same warranty terms that
the original manufacturer of such equipment provide with their product (refer to the warranty
terms for such products in their respective manual).
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End User License Agreement

This End User License Agreement ("Agreement”) grants you the right to use the software contained
in this product (the “Software”) subject to the following restrictions: You may not: (i) copy the
Software, except for archive purposes consistent with your standard archive procedures; (ii) trans-
fer the Software to a third party apart from the entire product; (iii) modify, decompile, disassem-
ble, reverse engineer or otherwise attempt to derive the source code of the Software; (iv) export
the Software or underlying technology in contravention of applicable U.S. and foreign

export laws and regulations; and (v) use the Software other than in connection with operation of

the product.

“"LICENSOR'S SUPPLIERS DO NOT MAKE OR PASS ON TO END USER OR ANY OTHER THIRD PARTY,
ANY EXPRESS, IMPLIED OR STATUTORY WARRANTY OR REPRESENTATION ON BEHALF OF SUCH
SUPPLIERS, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF NON-INFRINGE-
MENT, TITLE, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.”



Important Precautions and Useful Information

This preface contains information that will help you understand and safely maintain MCE
equipment. We strongly recommend you review this preface and read this manual before
installing, adjusting, or maintaining Motion Control Engineering equipment. This preface dis-
cusses:

« Safety and Other Symbol Meanings

« In This Guide

Safety and Other Symbol Meanings

A Danger
This manual symbol is used to alert you to procedures, instructions, or situations which, if not done

properly, might result in personal injury or substantial equipment damage.

Caution
This manual symbol is used to alert you to procedures, instructions, or situations which, if not done
properly, might result in equipment damage.

Note /

[
This manual symbol is used to alert you to instructions or other immediately helpful information.

In This Manual:

This manual is the installation and operation guide for the Sentry monitoring application.
When viewed online as a pdf file, hyperlinks link to related topics and informational web sites.
The manual includes:

« Contents: Table of Contents. When viewed online as a pdf file, hyperlinks in the Contents
link to the associated topic in the body of the manual.

« Section 1. General description and installation instructions.

« Section 2. Quick Start: Quick instructions for getting started using Sentry.

« Section 3. Reference: Detailed explanation of screen controls.

Ride=r MeE
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Sentry

Sentry is an elevator security interface application that sits between the MCE's iCue elevator
dispatcher and one of many non-MCE access control systems. For Sentry to work properly, the
access control system must have an integration with MCE's elevator protocol. Sentry runs on
the same PC as the iCue dispatcher. It waits for the access control application to connect to it; it
then translates messages between iCue and the access control software so that the dispatcher
does not need to change every time there is a new access control system introduced.

Through Sentry, the access control system may send over which floors require card access,
which floors are locked out and which floors are open to the public. Sentry allows for all secu-
rity schedules to be managed by the access control system instead of trying to synchronize
schedules on both the access control and elevator system. Sentry creates a path for the access
control system to send over card swipes over a network interface instead of one line per floor
relay interface, eliminating much of the wiring between access control and elevator systems.
Turnstiles can be implemented so that a card swipe registers a call automatically. Finally, Sen-
try sends valuable tracking information back to your access control to be logged, such as which
elevator was assigned a call and what floor was selected.

Sentry has an intuitive graphical user interface that can be used to see all information shared
between the access control system and the elevator system. Sending data over a network inter-
face is much more efficient than over discrete wires, but mechanics may worry that trouble-
shooting is harder in a black box. Not with Sentry! You will be able to see each card swipe sent
to and each acknowledgement from the dispatcher. Sentry keeps these in a local database so
any complaints can be investigated even after the fact.

42-02-S031 A2 1-1
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Card Readers
Card readers are the front end interface for the access control system. Through card readers the
access control systems are able to control access to elevators and/or floors by allowing or
restricting access based on the card holders access privileges programmed on their cards. MCE
touch screens can house a variety of supported card readers, which fall into either one of two
categories:

Segregated Readers: These readers are housed by MCE touch screen but are powered by and
communicate to the access control company directly. Sentry does not see any messages
between reader and access control. When access control gets a message, it sends floor destina-
tion data to Sentry.

MCE Dispatcher PC
192.168.191.201

Programs:

iCue Dispatcher

iView Config App

Sentry Security Interface (port 4600)

Elevator Network

Touch Screen

Ty
- 2
Card Reader

Touch Screen

Access Control Server

:l : (non-MCE)
- =

Card Reader

Integrated Readers: In this scenario, MCE installs HID 5127 multipurpose readers into the
touch screen housing. These readers are powered by the MCE touch screen and the touch
screen communicates directly with the readers over USB. When a card is swiped, the reader
sends data to the touch screen, which then uses the existing elevator communication to relay it
to the Sentry and Sentry sends a destination floor access request to the access control system.
This architecture requires access control system to be able to take card reads from Sentry and
saves dozens of extra hours of wiring every single card reader back to a panel board.

MCE Dispatcher PC
192.168.191.201

Programs:

iCue Dispatcher

iView Config App

Sentry Security Interface (port 4600)

Elevator Network

Touch Screen

T

Card Reader

Touch Screen

Access Control Server

‘ (non-MCE)
- R

Card Reader

1-2 Manual # 42-02-S031 A2
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Integrated Access Control Companies

Below is a list of access control systems that Sentry has direct integrations with. Please verify
with your MCE sales contact the version of access control available at time of sale.

Table 1.1 Integrated Access Control Companies

5\
]AMAG https://www.amag.com/

TECHNOLOGY
An ALLIED UNIVERSAL Compasry

BlU https://www.blubOx.com/
BWOS https://braxos.com/

— http://centennialsecurity.com/
DATAWATCH https://www.datawatchsystems.com/
W —_—w

v http://forteksecurity.com/

Gm https://www.genetec.com/

https://buildings.honeywell.com/us/en/brands/our-brands/security/

HOHBWE“ BUILDING TECHNOLOGIES

lCT https://www.ict.co/Solutions

le KASTLE https://www.kastle.com/
_

SYSTEMS

03' lE"El https://www.lenel.com/products/onguard
G utted Teckmotegion

SOFTWARE HOUSE  http://www.swhouse.com/products/software_ CCURE9000.aspx

_Contents | __Index | _MCE Web | 42-02-5031 A2 1-3
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Access Control systems available through BraXos

MCE can work with BraXos to connect to even more access control systems. BraXos would be
provided by the Security Contractor or Building Management. BraXos can integrate to the fol-
lowing companies without any change to Sentry.

« S2
« Siemens

Hotel Guest Cards
BraXos is also needed for Hotel system integration including Assa Abloy (Ving) or Kaba
(SafLok).

1-4 Manual # 42-02-5031 A2 Contents |  Index | MCE Web |
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Installation
Installing Sentry includes:

+ Determining Hardware Requirements
« Installing Sentry software
 Configuring Sentry

Determining Hardware Requirements

Sentry will normally be installed on the iCue dispatcher PC supplied by MCE. If there is a need
to install Sentry on a separate PC, the following configuration is a minimum.

» Microsoft Windows 7 Professional or greater
« 4GB RAM

« Intel 1.6 GHz i3 processor

» 10/100 Ethernet

« 1280x1024 display

Installing Sentry

1. Stop existing Sentry service, if one is running the MCE Sentry application, by clicking
the Stop button in the application window.

}Elh . @ v 8) @

e -

41

2. Exit Sentry GUI application.

B Maximize
= Minimize

rl:] Resize

3. Uninstall any previous versions of Sentry (see old versions below).
4. Insert new media (CD or USB Stick) with latest Sentry installer.
5. Copy Sentry Software installer to the PC Desktop.

6. Run Setup.exe and follow on screen instructions.

Old Versions:

If you have an older version of Sentry already installed, use Add/Remove Program function
from the Microsoft Windows Control Panel to remove it before installing new software.

_Contents | _ Index | MCE Web | 42-02-5031 A2 1-5
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Configuring Sentry
Any changes to the Sentry configuration require a restart of the Sentry application.

Connection to iCue
Sentry is set up to automatically connect to iCue if it is on the same PC. Sentry connects to only
one iCue. If there are multiple elevator banks in the building, each dispatcher will have its own
Sentry application running. The access control system is responsible for connecting to multiple
Sentry systems.

Authorization
The iCue must have a valid Sentry Authorization key enabled before Sentry will be allowed to
connect. Use iView to connect to the dispatcher and check that Sentry's authorization key has
been accepted.

Connect the iView configuration application to the iCue dispatcher.
@| iView | DBD Lab iCue =

File =~ ‘write privilege - View - Tools - Help -

WO MED

System Configuration

Remote Monitoring Authorization

- Building -
- CFSS [ To allow remote monitoring software to connect to the system please call MCE at

[—:I--Dispatc:hing 1-8300-444-7442.

Opthns _ Be ready to provide the type of monitoring system and the hardware
' Configurations key for each iCue/iController to be connected.
El- Hall Call Eligibility |
- Bank A Activate
- Bank B |
- Active Car Call Eligibility Comi| Hardware key |0xCA1E4857

& r"'!':'d_e Of Operation Actjvation code | Review Codes |
- Automatic |

i Lobby peak detection

Activate Deactivate |

Lobby peak op
Demand peak de on

-~ Demand peak options

.

- Balanced [ —Activated Clients
- Lobby peak |
. - iManitor
- Demand Up Peak !
Sent|
- Demand Down Peak - ]
-~ Parking

- Parking Bank B

- Parking Eligibility

- Split Bank |
=l Management

‘- Local Dispatcher

First, verify that Sentry is activated on the System Configuration > Management > Remote
Monitoring Authorization tab. If you do not see Sentry, contact MCE support to obtain an acti-
vation code.

1-6 Manual # 42-02-5031 A2 _Contents | _ Index | MCE Web |
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)

Nidec Mt Quick Start |

Sentry —

Sentry should always be running. If you need to start the graphical user interface:

Double click the desktop icon

The application should automatically come up and connect to iCue.

42-02-S031 A2 2-1
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CE Sentry

ACICPE.
MCE Reader Access Control | Turnstile Sentry Map Dispatcher Map

Tire Transaction Floor Side Status Source Call Security Map Destination Call Security Map
- 8/2/2019 8:10:21 PM | 24 7 Front| Pass = Floor Front Rear Front Rear
Flaor map
Frontmap 24567891011121314151617 18192021
Rear map:
Front HC map:
Rear HC map:
Travel data
Result code: Unknown Configuration . El
Car: 0 3
Source flocr: 2
Source side: Front
Cestination floor: 4
. |&/2/2019 5209 PM |23 2 |Front|Pass
. |e/2/2019 52008 M |22 2 |Front|Pass
. |&/2019 s2822PM |21 2 |Front|Pass
. |e2/2019 52745 PM |20 2 |Front|Pass o =
. |&/z019 s2620PM |19 2 |Front|Pass
. |&/zz2019 52519 PM |18 2 |Front|Pass
. |ss2r2018 52455 oM |17 2 Front | Pass 8
. |8/z2019 5:24200m (16 2 |Front|Pass e
. |8/2/2019 32408 PM |15 2 Front | Pass Om
. |erz2019 523520 |12 2 |Front|Pass LS
. |&/2/2019 ::23:228M (13 2 Front | Pass T
— hd m 3
Remote security status: @) Security override status: @  Elevator eligibility mode:| 0
Service status: G Running -a' ¢

Menu

Service Status
The Sentry background service is the software that does all the translating to access control sys-
tem. Check that the service is running by looking at the lower left corner of the application.

_ _ If the Service Status is showing stopped, start the service with the
Service status: ) Running  play button at the upper left of the ribbon.

Play = Start Sentry

N E @ Stop = Stop Sentry
Stop/Start =Restart the Sentry service. Do this after making any changes
to the Sentry parameters.

Browse Data @

In cases where you want to view data that has already transitioned off screen, select this button
to pick a data set and time window.

2-2 Manual # 42-02-S031 A2 _Contents | _ Index | MCE Web |
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Clear Screen |—-|

Menu

L

This button will clear out the data view so you can watch for new swipes or turnstile commands.
Data cleared is still in the data base.

Settings @|

This button will open the settings menu.

Note /

—~

1.

2.

B

10.

iCue IP Address: IP address of MCE iCue dispatcher. Use 127.0.0.1 if the MCE Sentry is
on the same PC as the iCue dispatcher.
Sentry Port: TCP port that Sentry is listening for an access control connection to connect
on. Default is 4600.
Enable Heartbeats:
« Checked: If Sentry does not see a heartbeat from the access system it will close the con-
nection (Default).
« Unchecked: Sentry does not look for access control heartbeats.
Heartbeat Receive Timeout: How long Sentry will wait before closing a connection if
watchdog option is checked (Default = 30 seconds).

Heartbeat Send Frequency: Number of seconds to send a application heartbeat to the
access control system if no other data is sent. May need to be 3 seconds for BraXos con-
nections.

Sentry treats passenger maps as source maps:

» No - map sent due to card swipe tells elevator system where passenger can go
(Default).

» Yes - map sent due to card swipe tells elevator system where passenger can leave from.
Card swipe bit value to allow access:

« 0 - access control sends a 0 to indicate passenger can go to a floor (Default).

« 1-access control sends a 1 to indicate passenger can go to a floor.

Source floor base: What number does the access control system consider the bottom
floor for messages about source floors (usually 0 or 1) Default is 1.

Destination floor base: What number does the access control system consider the bot-
tom floor for messages about destination floors (usually 0 or 1) Default is 1.

Home floor: Used by some access control systems to specify which floors this Sentry
should use for global turnstiles. For example, if there are two groups of elevators low
rise and high rise, the access control system could encode 0-20 as floors the low rise
serves and 21-40 as floors the high rise serves. This Sentry can be set to 21-40 to ignore
any turnstile messages with floor set to 0-20. If it sees a floor of 33, it will subtract 21 to
get an offset of 12 and Sentry will know that the turnstile message is for the 12th floor.

Restart Sentry for the setting changes to take effect.

About E|

Displays Sentry version information and MCE contact information.

Contents |

Index | MCE Web |
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Data Views

MCE Reader:

If the job has integrated MCE readers, this screen will show the data flow for each card from
MCE to the access control, then what floors the card can access, and finally the travel data back
from the elevator. This tab shows data from integrated readers (MCE card readers).

MCE Reader

Access Control

Turnstile

Time
9/13/2019 3:17-48 PM

Transaction Floor Side Kioskdd Mum of bits Bridge boa

37 1

Front

-
L

26

192.168.101 «

f13/2019 12:47:53 PM

36 7

Front|1

192.168.191

f13/2019 12:18:57 PM

35 7

Front|1

-

192.168.191

Card data

Floor map
Front map: 391011
Rear map:
Front HC map:
Rear HC map:

Travel data
Result code: Timed Out
Car: 0
Source floor: L1
Source side: Front
Destination floor: L1

64-81-87-00-00-00-00-00-00-00-00-00-00-00-00-00

9/13/2019 12:15:38 PM

Front

(%]

192.168.191

0/13/2019 12:15:29 PM

-5
-

Front|1

192.168.101

The Top Level shows the time, the transaction ID linking the MCE swipe with the access control
system, the floor the reader is on, the side, the kiosk ID, the number of bits MCE read from the
card, and the address of the bridge board the read came in on. The Card data shows the raw
card number that MCE sent to the access control system. The Floor map is the data returned by
the access control system for the passenger. This shows the floors the passenger is cleared to
use. The Travel data is the information sent back to the access control system for logging. This

includes the result of the swipe, car assigned, and floor traveled to.

2-4 Manual # 42-02-S031 A2
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Access Control:
This tab shows data from a segregated system (reader communicates to access control directly).

MCE Reader Access Control Turnsiile

Time Transachion Foor Side Kioskdd Status
. |9/13/2019 3:18:04 PM |38 7 |Front|1 Pass .

—_—

+ |9/13/2019 3:17:48 PM |37 1 Front|2 Pass

Hags
Vip:
Hospital:
Handicap:
Visitor:

m

Foor map
Front map: 391011
Rear map:
Front HC map: L
Rear HC map:

Travel data
Result code: Pass
Carid: 2
Source floor: L1 Source floor id: 0
Source side: Front
Destination floor: 3 Destination floor id: 0

+ |9/13/2019 30302 PM |0 (] Front|0 Pass

aA3/7Ma 257 0M |n li1  leenntln lpaee |

Each record can be expanded to show what floor map was sent by access control system (floors
the passenger was able to go to). Travel data is also paired to see which car was assigned and
which floor the passenger selected.

Note /

/—\'
Floor refers to floor label and Floor ID refers to the landing offset, with O (zero) being the bot-
tom floor.

m “ m 42-02-S031 A2 2-5
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Turnstile:
This tab shows data when a turnstile call is registered automatically from the access control sys-
tem.
MCE Reader Access Control Turnstile
Time Transaction Floor Side Status Dest floor Dest side Flags
= |BF272015 B:13:35 PM 3359 Front|Pass |5 Front 0
‘ 8272019 8:13:30 PM Front Pass 12
Travel data
Result code: Pass
Car: 0

Source floorn 2
Source side: Front
Destination floor: 0

Each record can be expanded to see the travel data associated.

Note /

T~

= |BF272015 Bil3:24 PM 33549 Frant|Pass |@ Front 0
. |s/2/2019 81313 PM |3359 Front|Pass  |& Front 0
. |s/2/2019 81252 P | 3358 Front|Pass |8 Frent 0

Floor refers to floor label and Floor ID refers to the landing offset, with O (zero) being the bot-

tom floor.

2-6 Manual # 42-02-S031 A2
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Building Map
Sentry shows the current building map on the right side of the program. This map is set by the
access control system to define floors and being either:

« Locked out (no one can access) - Padlock icon
» Require card access (secured) - S Key icon
« Open to the Public (unsecured) - Unsecured text

Destination maps control which floors you can select in an elevator.
Source maps control which floors you can call an elevator from.

Note /

T~
These maps are intended for display only. Use the access control system to change any values.

Sentry Map Dispatcher Map
Source Call Security Map Destination Call Security Map
Floor Front Rear Front Rear

29192

m 3

Sentry shows its current map from the access control application as well as the current map
being used by the dispatcher for troubleshooting. These should always match.

Contents |  Index | MCEWeb | 42-02-S031 A2 2-7




Diagnostic LEDs

Remote Secu rity Status Remote security status: G

This LED indicates that the elevator dispatcher is configured to use Sentry as a remote security
interface. If this LED is off, make sure the security type in iCue is set to Remote Security. Please
refer to “Security” on page 3-2.

Security Override Status ey overidestas @

This LED indicates that the elevator SECURITY OVERRIDE is active so the elevator system is
not going to use any security data from the access control system. If this LED is on, make sure
the iCue > Security configuration is set to Active. Please refer to “Security Type” on page 3-3.

Elevator Eligibility Mode F==tr=ligivility mode:| 0
This diagnostic shows which hall call eligibility map the iCue is currently using.

. 'ﬂ' WX
Connection Status »
This diagnostic shows the connection status between the access control software (shield) and
Sentry (gear) as well as connection status between Sentry (gear) and iCue elevator dispatcher
(diamond). If connection is lost a red X will be displayed on the line.

~ £ ~ 2

Checking Sentry is connected in iView
You can open the Security > Status screen in iView to check that Sentry is connected. Please
refer to “Sentry Connection Status” on page 3-4. The color of the LED circled indicates status:
« Red: Sentry is not connected
+ Yellow: Sentry is connected, but access control is not connected to Sentry
« Green: Both access control and Sentry are connected.

Vv Lue_Z 4 Zulb.dch
Guven e sty . S A S

File = ‘write privilege ~ View ~ Tools = Help -
”’ -,

oz [
Systern Configuration | Security |
General Status
I?:|--Genera| Master security emote security
; @ Active Q@ Not Connected

ds Hardware overrid :

H o P vcov @ Last swiped card data
‘Manage Lser Accounts @ Software override Activate Override |
" Hall calls Floor Door side Kiosk ID
Car Calls Aot PG
B . Active configuration & 0
[l Remote Security

- Credential Reader Options Off @ Hardware configuration

o Active Securlt.y Map @ software configuration

- Default Security Map

@ Timed ranfinnratinn

2-8 Manual # 42-02-S031 A2 _Contents | __Index | MCE Web |
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Setting Up Security - Elevator Side —
Connect iView configuration tool to the iCue Dispatcher. \ 3

42-02-S031 A2 3-1
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Security
Go to View > Configuration > Security and logon. Default password is manager

F - —
)| iView | SystemDefault2.dcfg E=RER™
File = ‘winte privilege = View = Tools + Help -
- Jo e B o=
Security
General
S cenerl
i Status —Security Level
' Configuration " No Security
i~ Manage Passwords
‘- Manage User Accounts " Basic Security with per floor codes
- Hall Calls ™ Basic Security with per floor and passenger codes
[#- Car Calls
- Remate Security * Remote Security
= | b | iCentra|| | -

Under the General tab, make sure that the Security Level is set to Remote Security.
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R MeE

Security Type

-
ﬂﬁﬁeu\rﬁystem[iefaulﬂ.dd% " A 2 " 28

File = ‘write privilege ~ View -~ Tools » Help -

oo M o=

Security

Remote Security

= General
o Status ;
- Configuration ty typ MCE Sentry Proxy R
|

Manage Passwords
Manage User Accounts
F- Hall Calls

- Car Calls

[BRFemote Security

Credential Reader Options
i Active Security Map
“ Default Security Map

Logon Logoft SavE

= | e | iCentraIl |

On the Remote Security tab, make sure the Security Type is set to MCE Sentry Proxy.
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Sentry Connection Status

(V| iMiew | DED Lab iCue s . & 8 - &
File ~ ‘write privilege = View ~ Tools ~ Help ~
HEE MEDE
System Configuration | Security
General Status ‘
= General —Master security Remaote security
Status : .
O Active AEE Sy Bia Ll e Sentry - Version 1.1.1
r Connected
Hard id .
i e o @ Last swiped card data
@ Software override Activate Override |
Floor Door side Kiosk ID
Remate Security —Active configuration e Front 0
1 @ Hardware configuration

@ Software configuration

@ Timed configuration

—Hall call security override
@ Enable 1

@ Enable 2

—Car call security overrides

al 2 5 4

L] L] L] L] Master

o o o o Enable 1

o o o o Enable 2

o o o o Passcodes

Lagon Logoff Send |
| 7@ | icentral 3/1/2017 7:04:51 PM Y

— o

| iView | DBD Lab iCue 2 2" e = | =

File = ‘ufrite privilege = View ~ Toocls ~ Help -

-
Ll

O [

Security

System Configuration

General Status

B General

Configuration

—Master security
O Active

@ Hardware override

@ Software override

Activate Override

—Remote security
MCE Sentry Proxy

Connected MCE Sentry - Version 1.1.1

@ Last swiped card data

Door side Kiosk ID

—Active configuration
"""" @ Hardware configuration
@ Software configuration

@ Timed configuration

On the Status tab, verify that the Remote security LED is Green and you have a version for MCE

Sentry.

+ Red LED = No connection between iCue and Sentry - check that Sentry is running.

* Yellow LED = iCue is connected to Sentry, but Sentry is not connected to the access con-
trol system. Verify access control system is running and can PING the PC running Sentry.
Verify access control is configured properly from their manufactures documentation.

« Green LED = iCue is connected to Sentry and Sentry is connected to access control sys-

tem.
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e

Mapping Readers and Touchscreens
The most crucial part of setting up a third party access system is mapping the card readers to
the right touch screens.

EIOSK 10 AND KIOSK TO CAR WALK TIMES

WALK TWE FR0M KSE (SEC]
| kit 1o EI_E':' .11|E|_E'n' .:..'-'lELE'-' mlELEu 44

ELEV. A2 ELEv. a4
{CAR C) [CAR D)

TOF LANDING (FLOOR LABELED “PH™ )

WALY TINE FAOM KWOSK (SEC)
| kios 0 | ELEV. A1|ELEY. AZ [ELEV. A3 |ELEV. A4
[ = [ I S R

(CAR C) =] (CaR D)

1= ]

ELEY, &7 ELEV. &1
(CaRr @) (CAR A)

Sth THRU 15th LAMDING (FLOOR LARELED: 8" THRU "t8" )
Jrd AND Ath LANDING ARE FALSE FLODRES

WALE THWE FROM KOSK [SEC)
RICSe 0 | ELEV. al[ELEW. A2 |ELEV. a3 [EIEV. &4
F]

1 2 [ 2
F i 1 2 2
SECURITY
DEEK
ELEY. Eu 3 ELEY. &4
(CaR C (CaR D) é

ENTRANCE

ELEV. A2 ELEY. A1
(Car B) {CAR A)

Zrd LAMDIMG (FLOOR LABELED ™" )

WAL TIWE_PROM MI05H [SEG.)
| wmosx o |eev. at[EEy. az [EIEY. &3 [EEV. &4
[ o - - 1 -1 =

ELEV. 44

@ [CAR D)
Bl —

BOTTOM LANDING (FLOOR LABELED °B™ )
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Above is a sample print showing kiosk (touch screen) IDs as numbers in circles. Notice that
multiple floors may have the same kiosk ID if the relationship between the kiosk and car doors
is the same.

In this example, kiosk ID 0 is at "B", kiosk IDs 1 and 2 are at floor "1", kiosk ID 3 is used for all
middle floors, and finally, kiosk ID 4 is used at "PH" the top floor.

F —— = =
(@] iView | SystemDefault2.dcfg =RNEN X
File » ‘irite privilege ~ View ~ Tools ~ Help ~
- = -
o e i o =z
Security | System Cenfiguration
ReaderOptions
—Credential Reader Definition -
Reader ID Floor Door Side Kiosk ID :
: s 2 B |=| Front |~ b |- |;
B Hall Calls
H- Car Calls 3 1 - Front |+ 1 -
B~ Remate Security
S Credential Reader Options 4 : M z v
' Active Securlty Map 5 3 - Frant - 3 -
= Default Security Map
& 3 - Front - 3 -
7 4 - Front - 3 -
8 5 - Front - 3 -
g 6 - Front - 3 -
10 7 - Front - 3 - 3
11 a3 - Frant |w 3 -
12 9 - Front - 3 -
13 10 - Front - 3 -
14 11 - Front - 3 -
15 12 - Front |- 3 -
16 14 - Front - 3 -
17 15 - Front - 3 -
18 PH - Front - 4 -
an RLA - Crent - n - i e
Logaon Logoff Save
% | @ | icentral Y
L

Go into Remote Security > Credential Reader Options and verify the mapping matches job
prints for floor, side, and Kiosk ID. The order and Reader ID is not important for the elevator
side but is important depending on how the access control system sends over data. Consult the
access control system documentation for instructions on matching Reader ID.
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Default Security Map

If security is activated, but the link between the access control and elevator system is broken,
you can configure the iCue to either use the last known security map (any secured floors end up
becoming locked out because there is no way to get card swipes), or you can set up a default
security map to go to. Again, any secured floors will end up being locked out because there is no
way to read a card swipe.

-

-

(9| iView | SystemDefault2.defg a — =R X
File » ‘irite privilege ~ View » Tools ~ Help ~
- = -
NS | o =
Security | Systemn Configuration
DefaultSecurityMap
B General
i - Status If communication to the security manager fails:
- Configuration : :
- Manage Fasswerds " Use last received map from security manager
{ " Manage User Accounts {+ Use default security map
Bl Hall Calls
B Car Calls ) Flaar Source Call Security Map Destination Call Security Map
- Remote Seu;url'mg-r . label Front Rear Front Rear
- Credential Reader Options PH
- Active Security Map I
a Default Security Map 15
14
12
11
10
9
8
7
6
5
4
3
2
1
B
Set Selection I
Logon | Logoff | Save
% | @& | icentral y

Go to Default Security map and set Use Default Map. Make sure to unsecure any floors that
need to be serviced if security link is broken. NOTE: Unsecured floors mean anyone has access
to them; they become public. Most offices will choose to make floors public if the security link is
broken, while laboratories, banks, or government buildings may choose to lock sensitive floors
down.
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Testing Security

Once the third party access system is connected to Sentry and it is connected to iCue (green
LED on Security Status page), we can start testing security features.

Override Security
To override security go into the Status tab and click the Activate Override button. Once clicked
it will turn into a Deactivate Override button and software override LED will light. During this
time all floors will be treated as public.

Note f

/‘\'
It may be a good idea to override security while testing so testing does not interrupt passenger
traffic. This decision depends on the type of building.

&
9| iView | DBD Lab iCue - ==
File = ‘write privilege =~ View ~ Tools = Help -

MO MED

Master security 1 Remote security

: tatus 2 MCE Sentry Proxy -
Active MCE Sentry - Version 1.1.1
Configuration ° o Connected "

lanage Passwords @ Hardware override
Manage User Accounts | O Software override:l Deactivate Override I
all Calls 2

Active configuration

@ Last swiped card data

Floor Door side Kiosk ID

Remote Security & Front 1}

Off @ Hardware configuration |

@ software configuration

@ Timed configuration
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Active Security Map
The first thing the access system should do after connecting to the elevators is send over a map
telling the elevators which floors will need card access and which are public. Verify this is cor-
rect in the Active Security Map.

@] iView | SystemDefault2.dcfg =RNE X
ik . @ - -
File = ‘rite privilege ~ View = Tools ~ Help ~
3 T, z -
NS o=
Security |Svstem Configuration
ActiveSecurityMap
=l General
- Status Security type MCE Sentry Proxy
- Configuration
-~ Manage Pass Floor Source Call Security Map Destination Call Security Map
- Manage User Accounts label Frant Rear Frant Rear
[+ Hall Call= PH
= Car Calls 16
- Configuration 15
- Mode Owverrides 14
=l Paszcodes 12
Floor 11
- Passenger 10
E- Remote Security g ‘
Credential Reader Options ]
M Active Security Map 7 e
‘- Default Security Map 6
5 12
4
&
2
i
B
Set Selection |
Lagaon | Lagaff | Save
= | @ | icentral v
~

This map is populated by the access control system. This example shows that the access control
system is telling the elevator system that a card is required to go to floor 5 or 7. Notice that
there are maps for both source and destination.

Securing a Source floor means that no one can call an elevator to pick them up at that floor
without a card. This is unusual and used only when an elevator serves public floors like outside
unmanaged parking levels.

Securing a Destination floor means you have to have a card with valid access to travel TO that
floor. This is the common type of security used in buildings.
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Testing Card Swipes
iView will show the last card swipe the dispatcher received. You can use this function to double
check that swiping a card is seen by the elevator system and that the mapping between kiosk
and reader is properly done.

—Remote security
o MCE Sentry Proxy

Caonnected MCE Sentry - Version 1.1.1

) Last swiped card data

Flaar Daaor side Kiosk ID

1 Front 2

The Last swiped card data LED will blink when a new swipe is seen. The data below the LED
will show the floor, side and kiosk ID sent.
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Troubleshooting

Here are a couple of tips on troubleshooting the system if it is not working.

1. The Access Control system will not connect to Sentry.

Confirm Sentry is installed and running (at least a yellow LED).

Confirm that Sentry is an authorized client in Remote Monitoring Authorization .
Confirm that Sentry is the latest version from MCE.

Confirm Access system can ping the PC IP address Sentry is running on.

Confirm connection settings on the Access system are correct.

Confirm there are no firewalls blocking a connection.

2. The Access Control System is connected, but will not send an Active Map.

Review Access Control documentation for how to set up the elevator map and schedule
changes based on timer tables.

Card swipes are not working.

Confirm Green Status light on iView Security Status menu.
Confirm kiosks are configured with kiosk IDs correctly.
Confirm reader mapping on Access Control side is set up correctly.

If multiple readers at same floor, try swiping each and then placing call from same
kiosk.

If swiping has opposite effect (passenger can only go to floors they are not supposed to
have access to and cannot go to floors they are set up to have access to), this indicates
opposite polarity in bitmasks between Sentry and Access Control. Sentry has an
option to flip on our side. Go to Settings button on Sentry GUI and check the option
"Passenger has access if Bitmask is" parameter. Change and restart Sentry to try.

4. Passengers can go to any floors, even ones that show up as secured in the Active Map.

Contents |  Index | MCE Web |

Confirm that Security Override is not set on the iView Security Status page.
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